Q1. Which among the following is not a mobile Operating System?
(a) Bada
(b) Safari
(c) Symbian
(d) MeeGo
(e) WebOS
Q2. Which among the following key can be used as a shortcut to rename a folder in Microsoft
Windows 8 and higher versions?
(a) F2
(b) F4
(c) F6
(d) F9
(e) F11
Q3. AT&T designed its first commercial modem, specifically for converting digital computer data
to analog signals for transmission across its long distance network. What is the name of the
modem?
(a) Telex
(b) Memex
(c) CompuServe
(d) Bell 103 dataset
(e) Dataphone
Q4. Integrated Chips or IC’s were started to be in use from which generation of Computers?
(a) 1st Generation
(b) 2nd Generation
(c) 3rd Generation
(d) 4th Generation
(e) 5th Generation
Q5. In Computer programming there is set of subroutine
definitions, protocols, and tools for building software and
applications. Which among the following is a term for sets of
requirements that govern how one application can talk to another?
(a) UPS
(b) API
(c) CGI
(d) J2EE
(e) OLE
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Q6. BSoDs can be caused by poorly written device drivers or malfunctioning hardware, such as
faulty memory, power supply issues, overheating of components, or hardware running beyond its
specification limits. Which color screen is displayed when encountered a BSOD Error?
(a) Red
(b) Grey
(c) Black
(d) Blue
(e) Green
Q7. Which among the following is the smallest unit in an image in a computer screen?
(a) Unit
(b) Pixel
(c) Array
(d) Resolution
(e) Clip
Q8. Microsoft Word is a word processor developed by Microsoft. In MS Word Spelling Check is a
feature available in which tab?
(a) File
(b) Home
(c) Insert
(d) Review
(e) References
Q9. There is a network that can connect networks ranging from small location or area to a bigger
range including public packet network and large corporate networks. That network's enterprise
allows users to share access to applications, services and other centrally located resources. Its
ability for a huge geographical access has transformed networking. Which among the following is
that network?
(a) SAN
(b) CAN
(c) LAN
(d) WAN
(e) MAN
Q10. Which among the following is not an Object Oriented Programming Language?
(a) Python
(b) PASCAL
(c) Java
(d) C++
(e) Ruby
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Q11. Which cloud is a cloud computing environment that uses a mix of on-premises, private cloud
and third-party, public cloud services with orchestration between the two platforms and it is
particularly valuable for dynamic or highly changeable workloads?
(a) Dynamic Cloud
(b) Advance Cloud
(c) Hybrid Cloud
(d) Sharing Cloud
(e) Combined Cloud
Q12. If you are allowing a person on the network based on the credentials to maintain the security
of your network, then this act refers to the process of ______.
(a) Authentication
(b) Automation
(c) Firewall
(d) Encryption
(e) Decryption
Q13. The use of combination of 1’s and 0’s is feature of which of the following type of Computer
Language?
(a) High Level Language
(b) PASCAL
(c) Machine Language
(d) C
(e) COBOL
Q14. Which among the following is a recently debated principle that Internet service providers
and governments regulating the Internet should treat all data on the Internet the same, not
discriminating or charging differentially by user, content, website, platform, application, type of
attached equipment, or mode of communication?
(a) Comcast
(b) Net Neutrality
(c) Oblique-net
(d) Net Fraternity
(e) Fair Web
Q15. Which among the following is an important circuitry in a computer system that directs the
operation of the processor?
(a) Memory
(b) Address Bus
(c) Accumulator
(d) ALU
(e) Control Unit
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Q16. MS Word is a text or document editing application program that comes in the package of MS
Office Suite. Which among the given options is not related with MS Word?
(a) Page Layout
(b) Antivirus
(c) Mailings
(d) Format Painter
(e) SmartArt
Q17. Which among the following is another name for a group of 4 bits?
(a) Nibble
(b) Byte
(c) Kilo Byte
(d) Mega Byte
(e) Peta Byte
Q18. Which among the given options is IBM’s Supercomputer?
(a) Tihane-2
(b) SunwayTaihu Light
(c) Watson
(d) Shasra-T
(e) Brain
Q19. Which is a feature included in Microsoft PowerPoint software that allows the user to see all
the slides in a presentation at one time?
(a) Slide Sorter
(b) Slide Master
(c) Handout Master
(d) Slide Header
(e) Reading View
Q20. Which among the given options does not have flash memory?
(a) Pen Drive
(b) Hard Disk
(c) Car Radio
(d) Memory Cards
(e) Memory Stick
Q21. Which of the following is not valid version of MS Office?
(a) Office 2010
(b) Office Vista
(c) Office 2007
(d) Office 2016
(e) None of the above
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Q22. Chief component of first generation computer was ____________.
(a) Transistors
(b) Vacuum Tubes and Valves
(c) Integrated Circuits
(d) VLSI
(e) ULSI
Q23. Which among the following is the largest space?
(a) Kilobyte
(b) Petabyte
(c) Terabyte
(d) Gigabyte
(e) Megabyte
Q24. Communication between walkie-talkies involves which of the following types of
transmission?
(a) Simplex
(b) Full -Duplex
(c) Half-Duplex
(d) Online
(e) None of these
Q25. The process of replacing Windows 8 with Windows 8.1 is called ________.
(a) Upgrading
(b) Updating
(c) Installing
(d) Downgrading
(e) Replacement
Q26. Example of telecommunication device is a ________ .
(a) modem
(b) printer
(c) keyboard
(d) scanner
(e) mouse
Q27. Which among the following is the reboot where the power to the system is physically turned
off and back on again, causing an initial boot of the machine?
(a) Toggle
(b) Cold booting
(c) Warm booting
(d) Logging off
(e) None of these
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Q28. Which of the following option may be used to change page-size and margins?
(a) Page Layout
(b) View
(c) Home
(d) Data
(e) Review
Q29. What is a Firewall in Computer Network?
(a) The physical boundary of Network
(b) An operating System of Computer Network
(c) A system designed to prevent unauthorized access
(d) A web browsing Software
(e) None of these
Q30. Which one of the following is an added set of one or more attributes taken collectively to
uniquely identify a record?
(a) Alternate key
(b) Sub key
(c) Super key
(d) Foreign key
(e) None of these
Q31. Bluetooth is an example of which of the following networks?
(a) Personal area network
(b) Local area network
(b) Virtual private network
(d) None of the above
(e) Wireless fidelity
Q32. What is the new default font used in MS Word document?
(a) Times New Roman
(b) Arial
(c) Algerian
(d) Preeti
(e) Calibri
Q33. Which is not an object oriented Programming language-?
(a) JAVA
(c) C++
(b) Python
(d) FORTRAN
(e) Ruby
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Q34. Who among the following sent the first electronic mail?
(a) Ray Tomlinson
(b) Charles Babbage
(e) J.Presper Eckert
(d) John W Mauchly
(e) Ana Lovelace
Q35. What are programs such as Microsoft Edge that serve as navigable windows into the Web
called as?
(a) Hypertext
(b) Web browsers
(c) Internet
(d) Networks
(e) Windows Navigator
Q36. Which among the following is a self-contained step-by-step set of operations to be performed?
(a) System Software
(b) Algorithm
(c) Network topology
(d) Application software
(e) Utility software
Q37. What is Remote Desktop Connection?
(a) It was known as Terminal Services in Windows Server 2008 and earlier, it is one of the
components of Microsoft Windows.
(b) a technology that allows you to carry your computer in remote areas.
(c) a technology that allows you to sit at the client computer and connect to the host remote computer
in a different location
(d) both (a) and (c)
(e) All of the above
Q38. When you save a Microsoft Access project, what file format do you use?
(a) .adp
(b) .Xml
(c) .gif
(d) .doc
(e) .pptx
Q39. What is the function of control unit?
(a) Providing resources to another node on a network
(b) Performing complex task of logical and arithmetic functions
(c) Memory usage
(d) Directing the operation of the other units by providing timing
and control signals.
(e) Displaying output to the end-user
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Q40. Which memory is non-volatile and may be written only once?
(a) RAM
(b) EPROM
(c) EEPROM
(d) PROM
(e) None of the above
Q41. Microsoft Office is a __________.
(a) Shareware
(b) Public-domain software
(c) Open source software
(d) An application suit
(e) Firmware
Q42. Which term is not related with font?
(a) Font face
(b) Font size
(c) Font color
(d) Font grammar
(e) None of these
Q43. The valid format of MS Word is __________.
(a) .jpeg
(b) .png
(c) .doc
(d) .exe
(e) None of these
Q44. Which of the following option may be used to change page-size and margins?
(a) Page Layout
(b) View
(c) Tools
(d) Data
(e) None of these
Q45. To justify the selected text, the shortcut key is __________.
(a) Ctrl + 1
(b) Ctrl + J
(c) Ctrl + U
(d) Ctrl + Alt + K
(e) None of these

8

www.bankersadda.com

| www.sscadda.com

|

www.careerpower.in

|

www. adda247.com

Q46. Workbook is a collection of __________ in MS Excel?
(a) page set-up
(b) buttons
(c) diagrams
(d) charts
(e) worksheets
Q47. In order to move from one worksheet to another in MS-Excel workbook. One should click
___________.
(a) active cell
(b) scroll bar
(c) sheet tab
(d) tab button
(e) None of these
Q48. In a spreadsheet, a __________ is a number you will use in a calculation.
(a) label
(b) cell
(c) field
(d) value
(e) None of these
Q49. In Power Point, which of the following will not advance the slides in a slide show view?
(a) Esc key
(b) The spacebar
(c) The Enter key
(d) The mouse button
(e) None of these
Q50. In Microsoft PowerPoint, two kinds of sound effects files that can be added to the
presentation are
(a) .wav files and .mid files
(b) wav files and .gif files
(c) wav files and .jpg files
(d) jpg files and .gif files
(e) None of these
Q51. Which PowerPoint view displays each slide of the presentation as a thumbnail and is useful
for rearranging slides?
(a) Slide Sorter
(b) Slide Show
(c) Slide Master
(d) Notes Page
(e) Slide Design

9

www.bankersadda.com

| www.sscadda.com

|

www.careerpower.in

|

www. adda247.com

Q52. If you want to insert a chart to your slide then go to __________.
(a) Insert – Chart
(b) Home – Chart
(c) Format – Chart
(d) Table – Chart
(e) None of these
Q53. Which of the following is not a type of Microsoft access database object?
(a) Table
(b) Worksheets
(c) Modules
(d) Macros
(e) None of these
Q54. Row in an Access table is also known as __________.
(a) field
(b) record
(c) data
(d) type
(e) None of these
Q55. Queries in Access can be used as __________.
(a) View, change and analyse data in different ways
(b) A source of records for forms and reports
(c) to access internet
(d) Both a and b
(e) None of these
Q56. Pressing F8 key for three times selects
(a) A word
(b) A sentence
(c) A paragraph
(d) Entire document
(e) None of these
Q57. What happens if you press Ctrl + Shift + F8?
(a) It activates extended selection
(b) It activates the rectangular selection
(c) It selects the paragraph on which the insertion line is.
(d) Both (a) and (c)
(e) None of these
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Q58. How can you disable extended selection mode?
(a) Press F8 again to disable
(b) Press Del to disable
(c) Press Esc to disable
(d) Press Enter to disable
(e) It cannot be disables
Q59. What does EXT indicator on status bar of MS Word indicate?
(a) It indicates whether the external text is pasted on document or not
(b) It indicates whether extended add-ons are installed on MS Word or not
(c) It indicates whether Extended Selection mode is turned on or off
(d) Both (a) and (b)
(e) None of these
Q60. What is the maximum number of lines you can set for a drop cap?
(a) 3
(b) 10
(c) 15
(d) 20
(e) 50
Q61. What is the default number of lines to drop for drop cap?
(a) 3
(b) 10
(c) 15
(d) 20
(e) 7
Q62. What is the shortcut key you can press to create a copyright symbol?
(a) Alt+Ctrl+C
(b) (b) Alt + C
(c) Ctrl + C
(d) Ctrl + Shift + C
(e) None of these
Q63. How many columns can you insert in a word document in maximum?
(a) 35
(b) 63
(c) 55
(d) 65
(e) 60
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Q64. What is the smallest and largest font size available in Font Size tool on formatting toolbar?
(a) 8 and 72
(b) 8 and 64
(c) 12 and 72
(d) 10 and 40
(e) None of these
Q65. Select all the text in MS Word document by:
(a) Ctrl + S
(b) Ctrl + 1
(c) Shift + A
(d) Ctrl + A
(e) None of these
Q66. In Access, this operation copies a backup file from the storage medium back onto the
computer :
(a) Restore
(b) Recreate
(c) Copy
(d) Structure
(e) None of these
Q67. MS Word is __________ software.
(a) System
(b) Application
(c) Programming
(d) Compiler
(e) None of these
Q68. The shortcut key for paste selected text/picture in MS Word is __________.
(a) Ctrl + X
(b) Ctrl + C
(c) Ctrl + V
(d) Ctrl + Z
(e) None of these
Q69. Using Print Preview is useful. When you want to
(a) colour the document
(b) save the document
(c) delete the document
(d) copy the document
(e) view how the document will appear when printed

12

www.bankersadda.com

| www.sscadda.com

|

www.careerpower.in

|

www. adda247.com

Q70. To indent the first paragraph of your report, you should use this key.
(a) Space bar
(b) Return key
(c) Tab key
(d) Shift key
(e) None of these
Q71. In Excel, the contents of the active cell are displayed in the ________.
(a) footer bar
(b) tool bar
(c) task bar
(d) menu bar
(e) formula bar
Q72. __________ appear at the bottom of the Excel Window.
(a) Work sheet tabs
(b) Name box
(c) Formula bar
(d) Title bar
(e) None of these
Q73. In MS excel __________ are numbered from 1 to onwards and __________ are numbered from
A to onwards.
(a) Columns, rows
(b) Rows, slides
(c) Slides, rows
(d) Rows, columns
(e) None of these
Q74. What is the default column width of MS Excel?
(a) 5.5
(b) 2.98
(c) 8.43
(d) 6.49
(e) None of these
Q75. To insert a new slide go to __________ tab, in the Slides group, click New Slide.
(a) Home
(b) View
(c) Animations
(d) Slide show
(e) None of these
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Q76. Times new Roman, Cambria, Arial are the example of __________.
(a) Font face
(b) Themes
(c) SmartArt
(d) Clipart
(e) None of these
Q77. In the Form Wizard dialog box, the fields from the selected table are displayed in which list
box?
(a) All fields
(b) All Records
(c) Available Records
(d) Available Fields
(e) None of these
Q78. In Access a __________ is the collection of data items of all the fields pertaining to one entity.
(a) field
(b) record
(c) form
(d) report
(e) None of these
Q79. A table of how many columns can you insert in a word document in maximum.
(a) 55
(b) 42
(c) 32
(d) 63
(e) As you wish
Q80. In MS Access a __________ name must be unique within a database.
(a) Field
(b) Record
(c) Table
(d) Character
(e) None of these
Q81. The minimum number of rows and columns in MS Word document is
(a) 1 and 1
(b) 2 and 1
(c) 2 and 2
(d) 3 and 3
(e) None of these
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Q82. Thesaurus tool in MS Word is used for
(a) Spelling suggestions
(b) Grammar options
(c) Synonyms and Antonyms words
(d) All of the above
(e) None of these
Q83. Why Drop Caps are used in document?
(a) To drop all the capital letters
(b) To automatically begin each paragraph with capital letter
(c) To begin a paragraph with a large dropped initial capital letter
(d) To drop the numbers
(e) None of these
Q84. A bookmark is an item or location in document that you identify as a name for future
reference. Which of the following task is accomplished by using bookmarks?
(a) To add anchors in web page
(b) To mark the ending of a paragraph of document
(c) To quickly jump to specific location in document
(d) To add hyperlinks in webpage
(e) None of these
Q85. A word processor would most likely be used to do
(a) Keep an account of money spent
(b) Do a computer search in media center
(c) Maintain an inventory
(d) Type a biography
(e) Maintain records of database
Q86. Which of the following is not valid version of MS Office?
(a) Office XP
(b) Office Vista
(c) Office 2007
(d) Office 2010
(e) None of these
Q87. You cannot close MS Word application by
(a) Choosing File menu then Exit submenu
(b) Press Alt+F4
(c) Click X button on title bar
(d) From File menu choose Close submenu
(e) None of these
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Q88. The key F12 in MS Word opens a
(a) Save As dialog box
(b) Open dialog box
(c) Save dialog box
(d) Close dialog box
(e) Opens help menu
Q89. What is the short cut key to open the Open dialog box?
(a) F12
(b) Shift F12
(c) Alt + F1
(d) Ctrl + F12
(e) None of these
Q90. Which of the following symbol sets would be most likely to contain a mathematical symbol
such as a degree sign, greater than or equal to, or a Greek letter?
(a) Wingdings
(b) Wingdings 3
(c) Webdings
(d) Symbol
(e) Arial
Q91. When assigning a shortcut key to a symbol, you should always try to select a key or key
combination that is:
(a) Unassigned
(b) Located on the ten-key pad section of your keyboard.
(c) Assigned to another task.
(d) From the same font family as the symbol.
(e) None of these
Q92. Suppose you wanted to create an AutoCorrect entry that would type the words ‘We regret to
inform you that your submission has been declined’ of the following choices, which would be the
best name you could assign to this entry?
(a) Regret
(b) Subdual
(c) We regret to inform you that your submission has been declined
(d) 11
(e) None of these
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Q93. If you want to convert a symbol or several lines of text into an AutoCorrect entry, you should:
(a) Insert the symbol or type the text in a Word document first. Then, select the text or symbol and go
to the AutoCorrect dialog box.
(b) Click the Tools menu and choose AutoCorrect Options. Then, click the Insert menu and choose
Symbol (or click the Format menu and choose Paragraph) to add the symbol or paragraph to
AutoCorrect.
(c) AutoCorrect can only accommodate one line of text. It is not possible to convert a symbol or
multiple lines of text into an AutoCorrect entry.
(d) Insert the symbol or type the text in a Word document first. Then, select the text or symbol and
click the Edit menu followed by Paste Special. Select New AutoCorrect Entry and then click OK.
(e) None of the above
Q94. AutoCorrect was originally designed to replace _________ words as you type.
(a) Short, repetitive
(b) Grammatically incorrect
(c) Misspelled words
(d) Incorrect Image
(e) None of the above
Q95. Which of the following is the second step in creating a macro?
(a) Start recording
(b) Using your mouse or keyboard, perform the task you want to automate
(c) Assign a keyboard shortcut to the macro
(d) Give the macro a name
(e) None of these
Q96. If you will be displaying or printing your document on another computer, you’ll want to
make sure and select the _____________ option under the ‘Save’ tab.
(a) Embed Fonts
(b) Embed True Type Fonts
(c) Save True Type Fonts
(d) Save Fonts
(e) Font Face
Q97. In Word, the mailing list is known as the ____________.
(a) Data sheet
(b) Source
(c) Data source
(d) Sheet
(e) Hyperlink
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Q98. In Microsoft Office Power-Point 2007, a _____ is a connection from one slide to another slide
in the same presentation or to a slide in another presentation, an e-mail address, a Web page, or a
file.
(a) Hyphenation
(b) Header
(c) Footer
(d) Hyperlink
(e) None of these
Q99. In PowerPoint, which of the following is the default page
setup orientation for notes pages, outlines and handouts?
(a) Vertical
(b) Landscape
(c) Portrait
(d) All of these
(e) None of these
Q100. In slide layout panel, how many layouts are available for next layout by default?
(a) 4
(b) 7
(c) 12
(d) 15
(e) None of these
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